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Contents of Package:
D-Link DI-704UP Express EtherNetwork
Broadband Router with USB Print Server
Manual, Warranty and Print Server Software on CD
Quick Installation Guide

Package Contents

If any of the above items are missing, please contact your reseller.

System Requirements for Configuration:

Power Adapter - AC 5V, 2A

WARNING! Using a power supply with a different voltage rating than
the one included with the DI-704UP will cause damage and void the
warranty for this product.

TM

Internet Explorer version 6.x, Netscape Navigator version 6.x
and above, or another Internet Browser application with
Javascript enabled

CAT5 Ethernet Cable

Computer with Windows, Macintosh, or Linux-based Operating
System with an installed Ethernet adapter
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Introduction
Thank you for purchasing the DI-704UP Express EtherNetwork Broadband Router
with USB Print Server. The DI-704UP is an Ethernet Broadband Router with a
built-in 4-port switch. It also features a USB port to share a USB printer on the
home or office network and includes a print server application for Windows. As
many as four computers can be connected directly to the router’s integrated
switch, using its four 10/100Mbps AutoMDIX Ethernet ports. More computers
can be added to the network by connecting additional switches to the DI-704UP.
The DI-704UP package even includes an Ethernet cable to get you started.

The DI-704UP is ideal if you are creating your first home or small business
network, or if you are a more advanced user looking for additional management
settings.

The DI-704UP includes a new, easy-to-use D-Link web-based graphical user
interface (GUI) to configure the router. To prevent unwanted Internet intruders
from accessing your private network, the DI-704UP also serves as a feature-
rich firewall.

So, whether you are a college student who wants to network with friends and
roommates, an executive working at home or in a small office, or a concerned
parent who just wants to have more control over how your children access the
Internet, then the D-Link  DI-704UP Express EtherNetwork Broadband Router
with USB Print Server is the networking solution for you.
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Network Address Translation - NAT allows your private net-
work to share a single public IP address. All your computer con-
nected to the DI-704UP will be on a private network shielded
from Internet intruders.

Features & Benefits

Firewall Features

Filtering - Easily applied filtering based on Media Access Con-
trol (MAC) Addresses, IP Addresses, Port Addresses, and time
schedule allows or denies computer on the network access to
the Internet.

Built-In 4-Port Switch - Allows you to quickly and easily share an Internet
connection with multiple computers and devices. Each 10/100 Ethernet
Port automatically senses and accepts the type of Category (CAT) 5
cable you attach - whether straight through or cross-over. Connect ad-
ditional switches to allow more computer to access the Internet.

Built-In Print Server - Includes a USB port to connect to a USB printer
and includes a Windows-based print server software application, so
users on the network can share the printer. The print server is also ca-
pable of TCP/IP printing.

Ethernet Cable Included - One Ethernet cable is included with the DI-
704UP to get you started.

Simple Setup Wizard for Easy Installation - The D-Link setup wizard
simplifies the installation process, getting you up and running in just a
few clicks.
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LEDs

LED LED Activity

Power A solid light indicates a proper connection to
the power supply.

Status

WAN A Solid light indicates connection on the
WAN port. This LED blinks during data
transmission.

Flashes consistently to indicate that the
DI-704UP is working properly. A solid light
indicates that the unit is not working
properly.

LOCAL
NETWORK
LEDs
(Ports 1-4)

A solid light indicates a connection to an
Ethernet-enabled computer on ports 1-4. This
LED blinks during data transmission.

POWER LED

Status LED Printer LEDWAN LED

LOCAL NETWORK LEDs

Printer A solid light indicates a proper connection to a
printer.
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Connections

WARNING!
Using a power supply with a different voltage rating than the one in-
cluded with the DI-704UP will cause damage and void the warranty for
this product.

Receptor for
Power Adapter

Reset button is to reset the device to its factory
default settings.

Reset Button

Printer Port

WAN port is the connection point for your DSL or
Cable modem.

WAN Port

LAN port is where you would connect each
computer to your network.

Connect  to the printer using a USB cable. This
feature is used to share the printer on the network.

Lan Ports

Connect the supplied power adapter that came
with the unit. Using the wrong power adapter will
damage the unit.

Receptor for Power Adapter

Reset ButtonPrinter Port WAN Port

LAN Ports

WARNING! Do not plug anything other than a USB printer into the
Printer Port. Doing so may cause damage and void the warranty for
this product.
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Introduction to Broadband
Router Technology
A router is a device that forwards data packets from a source to a destination.
Routers can work on Open System Interconnection (OSI) layer 3, which for-
wards data packets using an IP address and not a MAC address. A router will
forward data from the Internet to a particular computer on your LAN.

The information that makes up the Internet gets moved around using routers.
When you click on a link on a web page, you send a request to a server to show
you the next page. The request sent and the information received by your com-
puter is moved from your computer to the server using routers. A router also
determines the best route that your information should follow to ensure that the
information is delivered properly.

A router controls the amount of data that is sent through your network by elimi-
nating information that should not be there. This provides security for the com-
puters behind your router because computers from the outside cannot access
or send information directly to any computer on your network. The router deter-
mines which computer the information should be forwarded to and sends it. If
the information is not intended for any computer on your network, the data is
discarded. This keeps any unwanted or harmful information from accessing or
damaging your network.

Introduction to Firewalls
A firewall is a device that sits between your computer and the Internet that pre-
vents unauthorized access to or from your network. A firewall can be a com-
puter using firewall software or a special piece of hardware built specifically to
act as a firewall. In most circumstances, a firewall is used to prevent unautho-
rized Internet users from accessing private networks such as corporate LANs
and Intranets.

A firewall watches all of the information moving to and from your network and
analyzes each piece of data. Each piece of data is checked against a set of
criteria that the administrator configures. If any data does not meet the criteria,
that data is blocked and discarded. If the data meets the criteria, the data is
passed through. This method is called packet filtering.

A firewall can also run specific security functions based on the type of applica-
tion or type of port that is being used. For example, a firewall can be configured
to work with an FTP or Telnet server. Or a firewall can be configured to work
with specific UDP or TCP ports to allow certain applications or games to work
properly over the Internet.
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Introduction to Local Area Networking

A Local Area Network (LAN) is typically an Ethernet-based network that con-
nects several computers together over a small area such as a building or group
of buildings. LAN’s can also be connected over large areas. A collection of LANs
connected over a large area is called a Wide Area Network (WAN).

There are many types of media that can connect computers together. The most
common media is CAT5 cable; UTP or STP twisted pair wire. Each computer
must have a Network Interface Card (NIC), which transfers the data between
computers. A NIC is usually a 10/100Mbps Fast Ethernet adapter.

Most networks use hardware devices such as hubs or switches to transfer
data between computers. A hub receives data arriving through each port and
forwards the data to all other ports. A switch is more sophisticated, in that a
switch can determine the port (or corresponding computer) that each packet of
data is supposed to be delivered to. A switch minimizes network traffic and
speeds up communication over a network.

There are many types of scenarios to consider which could affect the operabil-
ity of a network. Some of these issues are discussed in the manual under the
Networking Basics section.
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Sample Scenario

You will need  broadband Internet access (a Cable or DSL subscription line into
your home or office).

Consult with your Cable or DSL provider for proper installation of the modem.

Connect the Cable or DSL modem to the DI-704UP wireless broadband router.
(See the Quick Installation Guide included with the DI-704UP.)

If you are connecting a desktop computer that does not already have an avail-
able Ethernet port to your network, you can install the D-Link DFE-530TX+
Ethernet adapter into an available PCI slot. (See the Quick Installation Guide
included with the DWL-530TX+.)

If you are connecting a laptop computer without an available Ethernet port to
your network, install an Ethernet Cardbus adapter (e.g., D-Link DFE-690TXD)
and its drivers into the laptop computer. (See the Quick Installation Guide
included with the DFE-690TXD.)

** Easily upgrade to a wireless network by adding a wireless Access Point (D-Link DWL-900AP+) **

Connect your USB printer to the USB printer port on the DI-704UP. Please
refer to the Quick Installation Guide for loading the Windows print server
software if on a Windows-based computer.

11111

55555

33333

22222

44444

66666

A  typical network setup in a home or small office (as shown above) might contain the
following devices. For specific information on setting up your network with the DI-704UP
please see the Network Setup section on the following page.
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Note:  Please see the Manual included with your modem for an explanation of
the modem’s LEDs.

Network Setup

Turn everything off.
A. Power OFF your Cable or DSL modem. If your modem does
not have an on/off switch, disconnect the power cable.
B. Turn OFF your computer.
C. Do NOT connect the power adapter to your D-Link router.

Connect the D-Link Router Cables.
A. Connect the Ethernet (or networking) cable from the Cable or
DSL modem to the WAN port of the router.
B. Use the D-Link supplied Ethernet cable to connect the Ethernet
port (Network Card) of your computer to one of the LAN ports of
the router. The complete setup should look like the image shown
above.

Power up the devices in sequence.
A. Power up the Cable or DSL modem. Wait until the modem has
made the connection to your Internet Service Provider’s (ISP’s)
network.

B. Power up the D-Link router by connecting the D-Link provided
power adapter to the router and to an available power outlet.
C. Turn on your computer.
D. Now, refer to either the Quick Installation Guide or continue
to follow this manual to complete the installation process.
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Using the Setup Wizard

The logon pop-up screen will appear.

Once you have logged in, the Home
screen will appear.

Click Run Wizard

Open your Web browser and
type “http://192.168.0.1” into the
URL address box. Then press the
Enter or Return key.

Type “admin” for the username and
leave the password field blank.

Click OK
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You will see the following screens.

Using the Setup Wizard (continued)

Set up your new password.
You have the option to
establish a password.

Click Next

Click Next
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Select your Internet
Connection.  You will be
prompted to select the
type of Internet connection
for your router.

Using the Setup Wizard (continued)

Set up your Time Zone. You
have the option to the set
standard time for your router.
To change the default
selection, select the drop
down arrow and choose the
correct time zone.

Click Next

If you are unsure of which setting to select,
please contact your Internet Service Provider.

Click Next

Select Others only if you use PPTP in Europe or
BigPond Cable in Australia.
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Using the Setup Wizard (continued)

If you selected Dynamic IP
Address, this screen will
appear:  (Used mainly for
Cable Internet service.)

If your ISP requires a Static
IP Address, and this option
is selected, then this
screen will appear:

Enter the IP Address informa-
tion originally provided to you
by your ISP. You will need to
complete all the listed fields.

What is a MAC address? Each
network adapter has a discrete
Media Access Control (MAC)
address. Note that some computers
and peripherals may already
include built-in network adapters.

Click Next

Click the “Clone MAC Address”
button to automatically copy the
MAC address of the network
adapter in your computer. You can
also manually type in the MAC
address.

Click Next
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If your ISP uses PPPoE
(Point-to-Point Protocol over
Ethernet), and this option is
selected, then this screen will
appear: (Used mainly for DSL
Internet service.)

Enter in the username and
password provided to you by
your ISP.

Using the Setup Wizard (continued)

Please be sure to remove any
existing PPPoE client software
installed on your computers.

Click Next

Click Restart

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


17

Using the Configuration Menu
Whenever you want to configure your network or the DI-704UP, you can access the
Configuration Menu by opening the web-browser and typing in the IP Address of the DI-
704UP.  The DI-704UP default IP Address is shown below:

Open the web browser.
Type in the IP Address of
the DI-704UP.

Home > Wizard

Note: If you have changed the default IP Address assigned to the DI-704UP, make sure to
enter the correct IP Address.

The factory default User name  is
“admin” and the default Password
is blank (empty).  It is recommended
that you change the admin password
for security purposes.  Please refer to
Tools>Admin to change the admin
password.

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


18

The Home>Wizard screen will appear upon log in.  Please refer to the Quick Instal-
lation Guide for more information regarding the Setup Wizard.

Using the Configuration Menu (continued)

Clicking Apply will save changes made to the page.

Clicking Cancel will clear changes made to the page.

Clicking Help will bring up helpful information regarding the page.

Clicking Restart will restart the router.  (Necessary for some changes.)

Home > Wizard (continued)
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Using the Configuration Menu (continued)
Home > WAN (continued)

WAN is short for Wide Area Network. The WAN settings can be referred to as the
Public settings. All IP information in the WAN settings are public IP addresses which
are accessible on the Internet. The WAN settings consist of four options: Dynamic IP
Address, Static IP Address, PPPoE, and Others. Select the appropriate option and fill
in the information needed to connect to your ISP.

Choose Dynamic IP Address to obtain IP address information automatically from your
ISP. Select this option if your ISP does not give you any IP numbers to use. This option
is commonly used for Cable modem services. Host Name: The Host Name field is
optional but may be required by some ISPs. The host name is the device name of the
Broadband Router.
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MAC Address:
The default MAC address is set to the WAN’s physical interface MAC address on the
Broadband Router. You can use the “Clone MAC Address” button to copy the MAC
address of the Ethernet Card installed by your ISP and replace the WAN MAC
address with this MAC address. It is not recommended that you change the default
MAC address unless required by your ISP.

Primary/Secondary DNS Address:
Enter a DNS Address if you do not wish to use the one provided by your ISP.

MTU:
Only enter the MTU if it is required by your ISP. Otherwise, leave it
at the default setting of 1500.

Auto-reconnect:
If enabled, the Broadband Router will automatically connect to your ISP after your
system is restarted or if the connection is dropped.

Using the Configuration Menu (continued)
Home > WAN (continued)
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IP Address:
Public IP address provided by your ISP.

Subnet Mask:
Subnet mask provided by your ISP.

ISP Gateway Address:
Public IP address of your ISP that you are connecting to.

Primary/Secondary DNS Address:
Enter a DNS Address if you do not wish to use the one provided by your ISP.

MTU:
Enter an MTU value only if required by your ISP. Otherwise, leave it at the default
setting of 1500.

Using the Configuration Menu (continued)
Home > WAN > Static IP Address

Choose Static IP Address if all WAN IP information is provided to you by your ISP. You
will need to enter in the IP Address, subnet mask, gateway address, and DNS address(es)
provided to you by your ISP. Each IP address entered in the fields must be in the appropriate
IP form, which are four IP octets separated by a dot (x.x.x.x). The Router will not accept
the IP Address if it is not in this format.

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


22

Using the Configuration Menu (continued)
Home > WAN > PPPoE

Please be sure to remove any Client Software program on your
computer before you start your configuration of the DI-704UP
Router. Choose PPPoE (Point to Point Protocol over Ethernet)
if your ISP uses PPPoE connection. Your ISP will provide you
with a username and password. This option is typically used for

DSL services. Select Dynamic PPPoE to obtain an IP address automatically
for your PPPoE connection. Select Static PPPoE to use a static IP address
for your PPPoE connection.
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Using the Configuration Menu (continued)
Home > WAN > PPPoE (continued)

Retype Password:
Re-enter PPPoE password.

Service Name:
Enter the service name provided by your ISP. (optional)

IP Address:
This option is only available for Static PPPoE. Enter in the static IP address for the
PPPoE connection.

Primary DNS Address:
Primary DNS IP provided by your ISP.

Secondary DNS Address:
Optional.

Maximum Idle time:
The amount of time of inactivity before disconnecting your PPPoE session. Enter a
Maximum Idle Time (in minutes) to define a maximum period of time for which the
Internet connection is maintained during inactivity. If the connection is inactive for longer
than the defined Maximum Idle Time, then the connection will be dropped. Either set
this to zero or enable Auto-reconnect to disable this feature.

MTU:
MTU stands for Maximum Transmission Unit. For PPPoE connections, you may need
to change the MTU settings in order to work correctly with your ISP.

Dynamic PPPoE:
PPPoE connection where you will receive an IP address automatically from your ISP.

Static PPPoE:
PPPoE connection where you have an assigned (static) IP address.

User Name:
Your PPPoE username provided by your ISP.

Password:
Your PPPoE password provided by your ISP.

Auto-reconnect:
If enabled, the Broadband Router will automatically connect to your ISP after your system
is restarted or if the connection is dropped.
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Dynamic IP Address for PPTP is a WAN connection used in Europe.

Using the Configuration Menu (continued)
Home > WAN > PPTP

My IP Address:
Enter in the IP address for the PPTP connection.

My Subnet Mask:
Enter the subnet mask information.

Server IP:
Enter the Server IP address. By default, its set to 192.168.0.1
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PPTP Account:
Enter in the username for the PPTP account.

Maximum Idle Time:
The amount of time of inactivity before disconnecting your PPTP session. Enter a
Maximum Idle Time (in minutes) to define a maximum period of time for which the
Internet connection is maintained during inactivity. If the connection is inactive for longer
than the defined Maximum Idle Time, then the connection will be dropped. Either set
this to zero or enable Auto-reconnect to disable this feature.

Auto-reconnect:
If enabled, the device will automatically connect to your ISP after your unit is restarted
or when the connection is dropped.

PPTP Password:
Enter the password for the PPTP account. Retype in Password to confirm.

Connection ID:
(Optional) Enter the Connection ID if required.

Using the Configuration Menu (continued)
Home > WAN > PPTP (continued)
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Account:
Enter in the username for the BigPond account.

Password:
Enter the password for the BigPond account.

Login Server:
(Optional) Enter the Login Server name if required.

Auto-reconnect:
If enabled, the device will automatically connect to your ISP after your unit is re-
started or when the connection is dropped.

Dynamic IP Address for BigPond is a WAN connection used in Australia.

Using the Configuration Menu (continued)
Home > WAN > BigPond Cable
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Using the Configuration Menu (continued)
Home > LAN

LAN is short for Local Area Network. This is considered your internal network. These
are the IP settings of the LAN interface for the DI-704UP. These settings may be
referred to as Private settings. You may change the LAN IP address if needed. The
LAN IP address is private to your internal network and cannot be seen on the Internet.

IP Address:
The IP address of the LAN interface. The default IP address is 192.168.0.1.

Subnet Mask:
The subnet mask of the LAN interface. The default subnet mask is 255.255.255.0.

Local Domain Name:
This field is optional. Enter in the your local domain name.
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DHCP stands for Dynamic Host Control Protocol. The DI-704UP has a built-in DHCP
server. The DHCP Server will automatically assign an IP address to the computers on
the LAN/private network. Be sure to set your computers to be DHCP clients by setting
their TCP/IP settings to “Obtain an IP Address Automatically.” When you turn your
computers on, they will automatically load the proper TCP/IP settings provided by the
DI-704UP. The DHCP Server will automatically allocate an unused IP address from the
IP address pool to the requesting computer. You must specify the starting and ending
address of the IP address pool.

Using the Configuration Menu (continued)
Home > DHCP
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Using the Configuration Menu (continued)
Home > DHCP

Static DHCP allows computers on the LAN to receive the same DHCP IP address
everytime it boots up. You can bind a specific IP address to a specific computer based
on the computer’s MAC address.

Starting IP address:
The starting IP address for the DHCP server’s IP assignment.

Ending IP address:
The ending IP address for the DHCP server’s IP assignment.

Lease Time:
The length of time for the IP lease.
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Using the Configuration Menu (continued)
Advanced > Virtual Server

The DI-704UP can be configured as a virtual server so that remote users accessing Web
or FTP services via the public IP address can be automatically redirected to local servers
in the LAN (Local Area Network). The DI-704UP firewall feature filters out unrecognized
packets to protect your LAN network so all computers networked with the DI-704UP are
invisible to the outside world. If public access is desired, you can make some of the LAN
computers accessible from the Internet by enabling Virtual Server. Depending on the
requested service, the DI-704UP redirects the external service request to the appropriate
server within the LAN network.

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


31

Using the Configuration Menu (continued)
Advanced > Virtual Server

The DI-704UP is also capable of port-redirection meaning incoming traffic to a particular
port can be redirected to a different port on the server computer. Each of the virtual
services that are created will be listed at the bottom of the screen in the Virtual Servers
List. There are already pre-defined virtual services already in the table. You may use
them by enabling them and assigning the server IP to use that particular virtual service.

Name:
The name referencing the virtual service.

Private IP:
The server computer in the LAN (Local Area Network) that will be providing the virtual
services.

Private Port:
The port number of the service used by the Private IP computer.

Protocol Type:
The protocol used for the virtual service.

Public Port:
The port number on the WAN side that will be used to access the virtual service.

Schedule:
The schedule of time when the virtual service will be enabled. The schedule may be
set to Always, which will allow the particular service to always be enabled. If it is set
to Time, select the time frame for the service to be enabled. If the system time is
outside of the scheduled time, the service will be disabled.

Example #1:
If you have a Web server that you wanted Internet users to access at all times, you
would need to enable it. Web (HTTP) server is on LAN (Local Area Network) computer
192.168.0.25. HTTP uses port 80, TCP.

Name: Web Server
Private IP: 192.168.0.25
Protocol Type: TCP
Private Port: 80
Public Port: 80
Schedule: always
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Using the Configuration Menu (continued)
Advanced > Virtual Server

Example #2:
If you have an FTP server that you wanted Internet users to access by WAN port 2100
and only during the weekends, you would need to enable it as such. FTP server is on
LAN computer 192.168.0.30. FTP uses port 21, TCP.

Name: FTP Server
Private IP: 192.168.0.30
Protocol Type: TCP
Private Port: 21
Public Port: 2100
Schedule: From: 01:00AM to 01:00AM, Sat to Sun

• All Internet users who want to access this FTP Server must connect to it from port
2100. This is an example of port redirection and can be useful in cases where there
are many of the same servers on the LAN network.
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Using the Configuration Menu (continued)
Advanced > Application

Some applications require multiple connections, such as Internet gaming, video
conferencing, and Internet telephony. These applications have difficulty working through
NAT (Network Address Translation). Special Applications makes some of these
applications work with the DI-704UP. If you need to run applications that require multiple
connections, specify the port normally associated with an application in the Trigger
Ports  field, then enter the public ports associated with the trigger port into the Public
Ports field.
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Using the Configuration Menu (continued)
Advanced > Application

At the bottom of the screen, there are defined special applications. To use them, select
one from the drop down list and select an ID number you want to use.  Then click the
“Copy to” button and the router will fill in the appropriate information to the list. You will
then need to enable the service. If the mechanism of Special Applications fails to make
an application work, try using DMZ host instead.

Note! Only one PC can use each Special Application tunnel.

Trigger Port:
This is the port used to trigger the application. It can be either a single port or a range of
ports.

Special Application List:
In the Special Application List, it will list some of the popular services with its trigger
ports. This is the port number on the WAN side that will be used to access the application.
You may define a single port or a range of ports. You can use a comma to add multiple
ports or port ranges.

Enable / Disable:
Select to activate the policy. To disable the virtual server feature, select disable.

Trigger Type:
Select the trigger protocol you would like to initiate. To change the selection, use the
drop down arrow and other choices will be listed.

Public Type:
Enter in the protocol type for public ports to access.  To change the selection, use the
drop down arrow and other choices will be listed.

Public Ports:
Enter in the public port or ports to be used.  A range of ports can be specified with a
hyphen.
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Using the Configuration Menu (continued)
Advanced > IP Filter

Use IP (Internet Protocol) filters to allow or deny computers access to the Internet based
on their IP address.
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Using the Configuration Menu (continued)
Advanced > IP Filter

Protocol:
Select the protocol type to block certain IP addresses.

IP Address:
Enter in the IP address range of the computers that you want the policy to apply to.  If it
is only a single computer that you want the policy applied to, then enter the IP address of
that computer in the Start Source IP and leave the End Source IP blank.

Port Ranges:
Enter in the port range of the TCP/UDP ports that you want the policy to apply to.  If it is
only a single port  that you want the policy applied to, then enter the port number in the
Start Port  field and leave the End Port field blank.  If you want to use all the ports, you can
leave the port range empty.

Schedule:
Select Always, or choose From and enter the time period during which the IP filter policy
will be in effect.

Enabled / Disabled:
Click Enabled to apply the filter policy or click Disabled to enter an inactive filter policy
(You can reactivate the policy later.)
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Using the Configuration Menu (continued)
Advanced > MAC Filters

MAC (Media Access Control) Filters are used to allow or deny LAN (Local Area Network)
computers from accessing the Internet and network by their MAC address.

At the bottom of the screen, there is a list of MAC addresses from the DHCP client
computers connected to the DI-704UP. To use them, select one from the drop down list
and select an IP number you want to use. Then click the “Copy to” button and the DI-
704UP will fill in the appropriate information to the list.
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Using the Configuration Menu (continued)
Advanced > MAC Filters

MAC Address:
Enter the MAC Address of the client that will be filtered.

DHCP Client:
Select from the DHCP Client list and click the Clone button to automatically clone that
computer’s MAC address to the MAC address field.

Name:
Enter the Name to create a profile for the associated computer(s) on the network.

Only deny computers with MAC address listed below to access the
network:
Select this option to deny only computers that are in the list access to the network
and Internet. All other computers will be allowed access to the network and Internet.

Only allow computers with MAC address listed below to access the
network:
Select this option to allow only computers that are in the list access to the network
and Internet. All other computers will be denied access to the network and Internet.

Disabled MAC Filter:
Select this option if you do not want to use MAC filters on your Local Area Network
(LAN).
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Using the Configuration Menu (continued)
Advanced > URL Blocking

Use URL Blocking filters to disallow computer(s) to access Internet with the following
URL keywords entered into the list. The URL Blocking filters are useful features that are
similar to parental control. Users can enter keywords that may have adult content,
hack, or other materials to prevent computers connected to the Local Area Network
(LAN) from accessing those web sites.
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Using the Configuration Menu (continued)
Advanced > Domain Filter

Use Domain filters to allow or deny computers access to specific Internet domains
whether it is through www, ftp, snmp, etc.  Domain filters apply to wired computers
connected to one of the four Ethernet LAN ports  to the DI-704UP.
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Using the Configuration Menu (continued)
Advanced > Domain Filter

Delete:
Select this option to remove the domain suffix from the Permitted Domains or Blocked
Domains list.

Permitted Domains:
Enter in the domain suffix of the Internet domain you want to use.
 (Example:  shopping.com,  sports.net.)

Deny users to access the following domains and permit all other domains:
Select this option to deny users to access the specified Internet domains listed below.
Users will be allowed access to all other Internet domains.

Allow users to access the following domains and block all other domains:
Select this option to allow users to access the specified Internet domains listed below.
Users will be denied access to all other Internet domains.

Disabled Domain Filter:
Select this option if you do not want to use Domain filters.

Blocked Domains:
Enter in the domain suffix of the Internet domain you want to block.
(Example: shopping.com, sports.net.)
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Firewall Rules is an advanced feature used to allow or deny traffic from passing through
the Broadband Router. It works in the same way as IP Filters with additional settings.
You can create more detailed access rules for the DI-704UP. When virtual services are
created and enabled, it will also display in Firewall Rules. Firewall Rules contains all
network firewall rules pertaining to IP (Internet Protocol).

In the Firewall Rules List at the bottom of the screen, the priorities of the rules are
from top (highest priority) to bottom (lowest priority.)

Note: The DI-704UP MAC Address filtering rules have precedence over the Firewall
Rules.

Using the Configuration Menu (continued)
Advanced > Firewall
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Using the Configuration Menu (continued)
Advanced > SNMP

SNMP (Simple Network Management Protocol) is a widely used network monitoring and
control protocol that reports activity on each network device to the administrator of the
network. SNMP can be used to monitor traffic and statistics of the DI-704UP. The DI-
704UP supports SNMP v1.

Enabled or Disabled:
Click Enabled to enable SNMP. Click Disabled to de-activate SNMP.

Get Community:
“Read only” access for network administration using SNMP.  You can view the network,
but no configuration is possible with this setting.

Set Community:
“Read and Write” access for network administration using SNMP.  The administrator can
configure the network with this setting.

Local:
SNMP services will be available on the Local (LAN) network.

Remote:
SNMP services will be available on the remote (WAN) network.
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Using the Configuration Menu (continued)
Advanced > DDNS

DDNS (Dynamic Domain Name System) keeps dynamic IP addresses (e.g., IP ad-
dresses assigned by a DHCP capable router or  server) linked to a domain name. Users
who have a Dynamic DNS account may use this feature on the DI-704UP.

DDNS:
When an IP address is automatically assigned by a DHCP server, DDNS automatically
updates the DNS server.

Provider:
Select your provider from the pull-down menu.

Host Name:
Enter the Host name.

Username/Email:
Enter the username/email address.

Password/Key:
Enter the password/key.
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Using the Configuration Menu (continued)
Advanced > Routing

Static routes can be added if you require specific routes within your internal network.
These routes will not apply to the WAN network.

Hop Count -  in a transmission path, each link is terminated at a network device
such as a router or gateway. The number of hops equals the number of routers or
gateways that data must pass through before reaching the destination.

Destination:
Enter in the IP of the specified network that you want to access using the static route.

Subnet Mask:
Enter in the subnet mask to be used for the specified network.

Gateway:
Enter in the gateway IP address to the specified network.

Hop:
Enter in the amount of hops it will take to reach the specified network.

Enable:
Select this option for the specified static route to take effect.
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Using the Configuration Menu (continued)
Advanced > DMZ

If you have a computer that cannot run Internet applications properly from behind the
DI-704UP, then you can allow that computer to have unrestricted Internet access. En-
able this feature and enter the IP address of that computer as a DMZ (Demilitarized
Zone) host with unrestricted Internet access. Adding a client to the DMZ may expose
that computer to a variety of security risks; so only use this option as a last resort.
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Using the Configuration Menu (continued)
Tools > Admin

Administrator Settings
At this page, the DI-704UP administrator can change the system password. There are
two accounts that can access the Broadband Router’s Web-Management interface.
They are admin and user. Admin has read/write access while user has read-only access.
User can only view the settings but cannot make any changes.
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Using the Configuration Menu (continued)
Tools > Admin

Remote Management:
Remote Management allows the DI-704UP to be configured from the Internet by a web
browser. A username and password is still required to access the Web-Management
interface. In general, only a member of your network can browse the built-in web pages
to perform “Administrator” tasks. This feature enables you to perform “Administrator”
tasks from the remote (Internet) host.

IP Address:
Internet IP address of the computer that has access to the Broadband Router. It is not
recommended that you set the IP address to 0.0.0.0, because this allows any Internet
IP address to access the Broadband Router, which could result in a loss of security
for your network. If you elect to Enable Remote Management, enter the IP Address of
your remote location.

Port:
Select the port number used to access the Broadband Router.

Example: http://x.x.x.x:8080 whereas x.x.x.x is the WAN IP address of the Broadband
Router and 8080 is the port used for the Web-Management interface.

Tools > Time

The system time is the time used by the DI-704UP for scheduling services. You can
manually set the time or connect to a NTP (Network Time Protocol) server. If an NTP
server is set, you will only need to set the time zone.
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Using the Configuration Menu (continued)
Tools > System

Save Settings to Local Hard Drive:
Click Save to save the current settings to the local Hard Drive.

Load Settings from Local Hard Drive:
Click Browse to find the settings file, then click Load.

Restore to Factory Default Settings:
Click Reset to Default to restore the factory default settings.

The current system settings can be saved as a file onto the local hard drive. The saved
file or any other saved setting file created by the DI-704UP can be uploaded into the unit.
To reload a system settings file, click on Browse to search the local hard drive for the
file to be used. The device can also be reset back to factory default settings by clicking
on the Reset to Default button. Use the restore feature only if necessary. This will erase
previously saved settings for the unit.  Make sure to save your system settings to the
hard drive before doing a factory restore.
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Using the Configuration Menu (continued)
Tools > Firmware

You can upgrade the firmware by using this tool. First, check the D-Link support site for
firmware updates at http://support.dlink.com. Make sure that the firmware you want to
use is saved on the local hard drive of your computer. Click on Browse to search the
local hard drive for the firmware that you downloaded from the D-Link website to be used
for the update. Upgrading the firmware will not change any of your system settings but
it is recommended that you save your system settings before doing a firmware upgrade.

Browse:
After you have downloaded the new firmware, click Browse in this window to locate the
firmware update on your hard drive.  Click Apply to complete the firmware upgrade.

Note! Do not power off the unit when it is being upgraded. When the
upgrade is complete, the unit will be restarted automatically.
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Using the Configuration Menu (continued)
Tools > Misc
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Using the Configuration Menu (continued)
Tools > Misc

Block WAN Ping:
Click Enable to block the WAN ping.  Computers on the Internet will not get a reply back
from the DI-704UP when it is being “ping”ed. This may help to increase security.

Reboot:
Click Reboot to restart the unit.

SPI Mode:
Stateful Packet Inspection is a form of firewall protection that will inspect all of the pack-
ets transmitted through the DI-704UP. It carefully inspects all incoming packets and if the
packets contain suspicious information, it will automatically drop those packets.

VPN Pass Through:
For users who telecommute or use Virtual Private Network (VPN), you can select PPTP
or IPSec to be used with this router.

UPnP Setting:
Universal Plug and Play is a feature that is preset to allow certain popular applications
such as MSN messenger to be functional using the router without making any configura-
tions. By default, theUPnP Setting is set to enable. It is recommended to keep the UPnP
Setting on enable.

Non-standard FTP port:
If an FTP server you want to access is not using the standard port 21, then enter in the
port number that the FTP server is using instead.

Ping Test:
This  diagnostic utility can be used to check if a computer is on the Internet. It sends
ping packets and listens for replies from the specific host.
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Using the Configuration Menu (continued)
Status > Device Info

This page in the Configuration Utility displays the current information for the Broadband
Router. It will display the WAN, LAN, and MAC address information. If your WAN
connection is set up for Dynamic IP address a Release button and Renew button
will be displayed. Use Release to disconnect from your ISP and use Renew to connect
to your ISP. If your WAN connection is set up for PPPoE, a Connect button and
Disconnect button will be displayed. Use Disconnect to drop the PPPoE connection
and use Connect to establish the PPPoE connection. This page allows you to observe
the DI-704UP’s working status:
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Using the Configuration Menu (continued)
Status > Device Info

LAN
LAN MAC Address:
Displays the LAN port MAC/hardware address.

IP Address:
LAN/Private IP Address of the DI-704UP.

Subnet Mask:
LAN/Private Subnet Mask of the DI-704UP.

WAN
WAN MAC Address:
Displays the WAN port MAC/hardware address.

IP Address:
WAN/Public IP Address.

Subnet Mask:
WAN/Public Subnet Mask.

Gateway:
WAN/Public Gateway IP Address.

Domain Name Server:
WAN/Public DNS IP Address.

PeripheralPrinter:
Status of the USB print server port.
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Using the Configuration Menu (continued)
Status > Log

The Broadband Router keeps a running log of events and activities occurring on the
router. If the device is rebooted, the logs are automatically cleared. You may save the
log files under Log Settings.

First Page:
The first page of the log.

Last Page:
The last page of the log.

Previous:
Moves back one log page.

Next:
Moves forward one log page.

Clear:
Clears the logs completely.

Log Settings:
Brings up the page to configure the logs.
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Using the Configuration Menu (continued)
Status > Log Settings

Send E-Mail alert to:
Enter in the email address of the recipient who will receive the email log.

Log Settings
Displays the logs of activities and events, and can be setup to send these logs to
another location.

E-Mail Alert:
The DI-704UP can be set up to send the log files to a specific email address.

SMTP Server IP:
Input the SMTP information. Usually, this is provided by your Internet Service Provider
(ISP).

Send Mail Now:
Click to send mail now.
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Using the Configuration Menu (continued)
Help

Help
This menu displays the complete Help menu. For help at anytime, click on the Help tab
in the configuration menu.
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Installing the Print Server Software
Insert the installation CD-ROM into the CD-ROM drive. The following window will be
shown automatically. If it is not, please run “install.exe” on the CD-ROM.

Click Next

Click Install Print
Server Software

Click to Install Print
Server Software for
either Windows 98SE/ME
or Windows 2000/XP
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Installing the Print Server Software (continued)

Select the destination folder.

After rebooting your computer, the software installation procedure is finished.

Click Next

Click Browse to
select a destination
folder

Click Finish

Click OK

Select the
option for
restarting the
computer.
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Configuring on Windows 98SE/ME Platforms
After you finish the software installation proce-
dure, your computer will be capable of network
printing provided by the DI-704UP. On a Win-
dows 95/98 platform, open the Printers win-
dow in the My Computer menu.

Now, you can configure the print server of
the DI-704UP: Find the corresponding
icon for your printer, for example, the
Epson Stylus C60 Series. Right click on
that icon, and then select Properties.

The screen at the right will appear.

Choose the “D-Link LPT port (Print
Server)” from the list attached at the Print
To item. Be sure that the Printer Driver
item is configured to the correct driver of
your printer.

Click on the
Details tab

Click Port Settings

Installing the Print Server Software (continued)
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Configuring on Windows XP/2000/NT Platforms

The configuration procedure for a Windows
2000/XP platform is similar to that of Win-
dows 95/98 except the screen of printer Prop-
erties:

Click Port

Click Configure Port

Type in the IP address of the
DI-704UP.

Click OK

(Note: Screen shots are taken in Windows 2000, similar
screens will appear in Windows XP.)

Type in the IP address of the DI-704UP.

Click OK

Installing the Print Server Software (continued)
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In this section you will learn how to establish a network at home or work,
using Microsoft Windows XP.

Note:  Please refer to websites such as http://www.homenethelp.com
and http://www.microsoft.com/windows2000  for information about

networking computers using Windows 2000, ME or 98SE.

Go to Start>Control Panel>Network Connections
Select Set up a home or small office network

Networking Basics

To continue, click Next.

Using the Network Setup Wizard in Windows XP
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Please follow all the instructions in this window:

Networking Basics (continued)

Click Next

In the following window, select the best description of your computer.  If your
computer connects to the Internet through a gateway/router, select the
second option as shown.

Click Next

Using the Network Setup Wizard in Windows XP

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


64

Enter a Computer description and a Computer name (optional.)

Networking Basics (continued)

Click Next
Enter a Workgroup name.  All computers on your network should have the
same Workgroup name.

Click Next

Using the Network Setup Wizard in Windows XP
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Please wait while the Network Setup Wizard applies the changes.

Networking Basics (continued)

When the changes are complete, click Next.

Please wait while the Network Setup Wizard configures the computer.
This may take a few minutes.

Using the Network Setup Wizard in Windows XP
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Networking Basics (continued)

Insert a disk into the Floppy Disk Drive, in this case, drive A.

Format the disk if you wish, and click Next.

In the window below, select the option that fits your needs.  In this example, Create a
Network Setup Disk has been selected.  You will run this disk on each of the
computers on your network.  Click Next.

Using the Network Setup Wizard in Windows XP
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Networking Basics (continued)

Please read the information under Here’s how in the screen below.  After you com-
plete the Network Setup Wizard you will use the Network Setup Disk to run the
Network Setup Wizard once on each of the computers on your network.

Please wait while the Network Setup Wizard copies the files.

To continue, click Next.

Using the Network Setup Wizard in Windows XP
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Networking Basics (Continued)

The new settings will take effect when you restart the computer.  Click Yes to
restart the computer.

You have completed configuring this computer.  Next, you will need to run the
Network Setup Disk on all the other computers on your network.  After run-
ning the Network Setup Disk on all your computers, your new  network will be
ready to use.

Using the Network Setup Wizard in Windows XP

Please read the information on this screen, then click Finish to complete the
Network Setup Wizard.
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Networking Basics (Continued)

Select the Computer
Name Tab in the System
Properties window.

Enter a Computer De-
scription; this field is
optional.

To rename the computer or
join a domain, Click
Change.

To name your computer, please follow these directions: In Windows XP:

Click Start (in the lower left corner of the screen)

Naming your Computer

Right-click on My Computer

Select Properties
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Assigning a Static IP Address in Windows XP/2000
Note:  Residential Gateways/Broadband Routers will automatically assign IP Ad-
dresses to the computers on the network, using DHCP (Dynamic Host Configura-
tion Protocol) technology.  If you are using a DHCP-capable Gateway/Router you
will not need to assign Static IP Addresses.
If you are not using a DHCP capable Gateway/Router or you need to assign a Static IP
Address, please follow these instructions:

Go to Start.

Double-click on
Control Panel.

Networking Basics (Continued)
Naming your Computer

In this window, enter the
Computer name.

Select Workgroup and enter
the name of the Workgroup.

All computers on your network
must have the same
Workgroup name.

Click OK.
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Networking Basics (Continued)
Assigning a Static IP Address in Windows XP/2000

Double-click on
Network
Connections.

Single-click on
Properties.

Right-click on Local Area
Connections.
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Networking Basics
Assigning a Static IP Address
in Windows XP/2000

You have successfully assigned a Static IP Address.

IP address:
e.g., 192.168.0.2
Subnet mask:
255.255.255.0
Default gateway:
Enter the LAN IP address of
the wireless router. (D-Link
wireless routers have a LAN IP
address of 192.168.0.1)

 In the window below, select Use the following IP address. Input your IP
address and subnet mask. (The IP Addresses on your network must be
within the same range. For example, if one computer has an IP Address of
192.168.0.2, the other computers should have IP addresses that are
sequential, like 192.168.0.3 and 192.168.0.4.  The Subnet mask must be
the same for all the computers on the network.)

Click OK.

 Select Use the following
DNS server addresses.
Enter the LAN IP address of
the Wireless Router.  (D-
Link wireless routers have a
LAN IP address of
192.168.0.1)

Click on Internet Protocol
(TCP/IP).

Click Properties.

Select Use the following IP
address in the Internet Proto-
col (TCP/IP) Properties window
(shown below).
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Networking Basics (Continued)

Go to the Apple Menu and
select System Prefer-
e n c e s .

Double-click on Network.

Select Built-in Ethernet in
the Show pull-down menu.

Select Using DHCP in the
Configure pull-down menu.

Click Apply Now.

The IP Address, Subnet
mask, and the Router’s IP
Address will appear in a
few seconds.

Selecting a Dynamic IP Address with Macintosh OSX
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Networking Basics
Checking the Connection by Pinging in Windows XP and 2000

Checking the Connection by Pinging in Windows Me and 98

Go to Start > Run >
type cmd.  A window
similar to this one
will appear.  Type
ping
xxx.xxx.xxx.xxx,
where xxx is the IP
Address of the
Router or Access
Point.  A good
wireless connection
will show four replies
from the Wireless
Router or Access
Point, as shown.

Go to Start > Run
> type command.
A window similar to
this will appear.
Type ping
xxx.xxx.xxx.xxx
where xxx is the IP
Address of the
Router or Access
Point.  A good
wireless connection
will show four
replies from the
wireless router or
access point, as
shown.
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Resetting the DI-704UP
to the Factory Default Settings
After you have tried other methods for troubleshooting your network, you may

To hard-reset the D-Link DI-704UP to the Factory Default Settings, please do
the following:

Use a paper clip to press the Reset button and power on.

Locate the Reset button on the back of the DI-704UP.

After you have completed the above steps, the DI-704UP
will be reset to the factory default settings.

Hold for about 5 seconds and then release. (Or release
when the status LED flashes.)

choose to Reset the DI-704UP to the factory default settings.
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Standard
IEEE 802.3 10Base-T Ethernet
IEEE 802.3u 100Base-TX Fast Ethernet
IEEE 802.3 NWay Auto-Negotiation
USB 1.1

VPN Pass Through
PPTP
L2TP
IPSec

Ports
One WAN
Four LAN

LEDs
Power
WAN
Printer
Local Network - 10/100

Operating Temperature
32oF to 131oF (0oC to 55oC)

Humidity
95% maximum (non-condensing)

Technical Specifications

Power
External Power Supply
AC 5V, 2A

Dimensions
L = 7.56 inches (192mm)
W = 4.64 inches (118mm)
H = 1.22 inches (31mm)

Weight
0.68 lbs (0.31kg)

Warranty
One Year
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Frequently Asked Questions

When entering the IP Address of the DI-704UP (192.168.0.1), you are not connecting
to the Internet or have to be connected to the Internet. The device has the utility built-
in to a ROM chip in the device itself. Your computer must be on the same IP subnet
to connect to the web-based utility.

To resolve difficulties accessing a  web utility, please follow the steps below.

Step 1     Verify physical connectivity by checking for solid link lights on the device. If
you do not get a solid link light, try using a different cable or connect to a different
port on the device if possible. If the computer is turned off, the link light will not be
on.

The following connections require a Crossover Cable:
Computer to Computer
Computer to Uplink Port
Computer to Access Point
Computer to Print Server
Computer/XBOX/PS2 to DWL-810
Computer/XBOX/PS2 to DWL-900AP+
Uplink Port to Uplink Port (hub/switch)
Normal Port to Normal Port (hub/switch)

The following connections require a Straight-through Cable:
Computer to Residential Gateway/Router
Computer to Normal Port (hub/switch)
Access Point to Normal Port (hub/switch)
Print Server to Normal Port (hub/switch)
Uplink Port to Normal Port (hub/switch)

Rule of Thumb:
”If there is a link light, the cable is right.”

What type of cable should I be using?

Why can´t I access the web based configuration?
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Frequently Asked Questions (continued)

What type of cable should I be using? (continued)
What´s the difference between a crossover cable and a straight-through
cable?
The wiring in crossover and straight-through cables are different. The two types
of cable have different purposes for different
LAN configurations. EIA/TIA 568A/568B
define the wiring standards and allow for
two different wiring color codes as
illustrated in the following diagram.

*The wires with colored backgrounds may
have white stripes and may be denoted
that way in diagrams found elsewhere.

How to tell straight-through cable from
a crossover cable:
The main way to tell the difference
between the two cable types is to compare
the wiring order on the ends of the cable. If
the wiring is the same on both sides, it is
straight-through cable. If one side has opposite wiring, it is a crossover cable.

All you need to remember to properly configure the cables is the pinout order of
the two cable ends and the following rules:
A straight-through cable has identical ends
A crossover cable has different ends

It makes no functional difference which standard you follow for straight-through
cable ends, as long as both ends are the same. You can start a crossover cable
with either standard as long as the other end is the other standard. It makes no
functional difference which end is which. The order in which you pin the cable is
important. Using a pattern other than what is specified in the above diagram
could cause connection problems.

When to use a crossover cable and when to use a straight-through cable:
Computer to Computer – Crossover
Computer to an normal port on a Hub/Switch – Straight-through
Computer to an uplink port on a Hub/Switch - Crossover
Hub/Switch uplink port to another Hub/Switch uplink port – Crossover
Hub/Switch uplink port to another Hub/Switch normal port - Straight-through

Why can´t I access the web based configuration? (continued)
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Step 3 Configure your Internet settings.

Step 2  Disable any Internet security software running on the computer. Software
firewalls like Zone Alarm, Black Ice, Sygate, Norton Personal Firewall, etc. might
block access to the configuration pages. Check the help files included with your
firewall software for more information on disabling or configuring it.

Frequently Asked Questions (continued)

Click to the Connection tab and set the dial-
up option to Never Dial a Connection. Click
the LAN Settings button

Nothing should be checked. Click OK

Go to the Advanced tab and click the
Restore Defaults button to restore
these settings to their defaults.

Click OK. Go to the desktop and close any open
windows

Go to Start>Settings>Control Panel. Double click
the Internet Options Icon. From the Security tab,
click the Default Level button to restore the
settings to their defaults.

Why can´t I access the web based configuration? (continued)
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Frequently Asked Questions (continued)

Step 4 Check your IP Address. Your computer must have an IP Address in the same
range of the device you are attempting to configure. Most D-Link devices use the
192.168.0.X range.

How can I find my IP Address in Windows 95, 98, or
ME?

Step 1 Click on Start, then click on Run.

Step 2 The Run Dialogue Box will appear. Type winipcfg in the text field and
then click OK.

Step 3 The IP Configuration window will appear, displaying your Ethernet
Adapter Information.

 Select your adapter from the drop down menu.
 If you do not see your adapter in the drop down menu, your adapter is

     not properly installed.

Step 4   After selecting your adapter, it will display your IP Address, subnet
mask, and default gateway.
Step 5  Click OK to close the IP Configuration window.

Why can´t I access the web based configuration? (continued)
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Frequently Asked Questions (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP Address
in the same range of the device you are attempting to configure. Most D-Link devices
use the 192.168.0.X range.

How can I find my IP Address in Windows 2000/XP?

Step 1 Click on Start and select Run.

Step 2 Type cmd then click OK.

Step 3 From the Command Prompt, enter ipconfig. It will return your IP
Address, subnet mask, and default gateway

Step 4 Type exit to close the command prompt.

Why can´t I access the web based configuration? (continued)
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Frequently Asked Questions (continued)

Step 4  (continued) Check your IP Address. Your computer must have an IP Address
in the same range of the device you are attempting to configure. Most D-Link devices
use the 192.168.0.X range.

Make sure you take note of your computer´s Default Gateway IP Address. The Default
Gateway is the IP Address of the D-Link router. By default, it should be 192.168.0.1.

How can I assign a Static IP Address in Windows XP?
Step 1
Click on Start > Control Panel > Network and Internet Connections >
Network connections.

Step 2 See Step 2 for Windows 2000 and continue from there.

How can I assign a Static IP Address in Windows 2000?
Step 1 Right-click on My Network
Places and select Properties.

Step 2 Right-click on the Local
Area Connection which represents
your network card and select
Properties.

Highlight Internet Protocol (TCP/
IP) and click Properties.

Why can´t I access the web based configuration? (continued)
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Frequently Asked Questions (continued)

How can I assign a Static IP Address in Windows 2000?
(continued)
Click Use the following IP Address and
enter an IP Address that is on the same
subnet as the LAN IP Address on your
router. Example: If the router´s LAN IP
Address is 192.168.0.1, make your IP
Address 192.168.0.X where X = 2-99.
Make sure that the number you choose is
not in use on the network.

Set the Default Gateway to be the
same as the LAN IP Address of your
router (192.168.0.1).

Set the Preferred DNS server to be the
same as the LAN IP address of your
router (192.168.0.1).

The Alternate DNS server is not needed or enter a DNS server from your ISP.

Click OK twice. You may be asked if you want to reboot your computer. Click
Yes.

How can I assign a Static IP
Address in Windows 98/Me?

Step 1 From the desktop, right-click on the
Network Neigborhood icon (Win ME - My
Network Places) and select Properties

Highlight TCP/IP and click the Properties
button. If you have more than 1 adapter,
then there will be a TCP/IP “Binding” for
each adapter. Highlight TCP/IP > (your
network adapter) and then click
Properties.

Why can´t I access the web based configuration? (continued)
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Frequently Asked Questions (continued)

How can I assign a Static IP Address in Windows
98/Me? (continued)
Step 2 Click Specify an IP Address.

Step 3 Click on the Gateway tab.

Enter the LAN IP Address of your router
here (192.168.0.1).

Click Add when finished.

Step 4 Click on the DNS Configuration tab.

Enter in an IP Address that is on the same
subnet as the LAN IP Address on your router.
Example: If the router´s LAN IP Address is
192.168.0.1, make your IP Address
192.168.0.X where X is between 2-99. Make
sure that the number you choose is not in
use on the network.

Step 5 Click OK twice.

Click Enable DNS. Type in a Host (can be
any word). Under DNS server search order,
enter the LAN IP Address of your router
(192.168.0.1). Click Add.

When prompted to reboot your computer,
click Yes.
After you reboot, the computer will now have
a static, private IP Address.

Why can´t I access the web based configuration? (continued)

Step 5 Access the web management. Open your web
browser and enter the IP Address of your D-Link device in
the address bar. This should open the login page for the web
management. Follow instructions to login and complete the configuration.

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


85

Frequently Asked Questions (continued)

How can I setup my router to work with a Cable modem connection?

Dynamic Cable connection
 (i.e. Cox, Adelphia, Rogers, Roadrunner, Charter, and Comcast).

Note: Please configure the router with the computer that was last connected directly
to the cable modem.

Step 1 Log into the web based
configuration by typing in the IP
Address of the router
(default:192.168.0.1) in your web
browser. The username is admin
(all lowercase) and the password
is blank (empty).

Step 2 Click the Home tab
and click the WAN button.

By default, Dynamic IP
Address is the selected option.

Click Clone Mac Address.

Click on Apply and then
Continue to save the changes.
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Frequently Asked Questions (continued)

How can I setup my router to work with a Cable modem connection?
(continued)

Step 3 Power cycle the cable modem and router:

First turn the cable modem off. Next, turn the router off Leave them off for 2 minutes**.
After 2 minutes**, turn the cable modem on.  Wait until you get a solid cable light on
the cable modem, and then turn the router on. Wait 30 seconds.

** If you have a Motorola (Surf Board) modem, leave off for at least 5 minutes.

Step 4 Follow step 1 again and log back into the web configuration. Click the Status
tab and click the Device Info button. If you do not already have a public IP Address
under the WAN heading, click on the DHCP Renew and Continue buttons.

Static Cable Connection
Step 1 Log into the web based configuration by typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The username is admin (all lowercase) and
the password is blank (empty).

Step 2 Click the Home tab and click the WAN
button. Select Static IP Address and enter your
static settings obtained from the ISP in the fields
provided.

If you do not know your settings, you must
contact your ISP.

Step 3 Click on Apply and then
click Continue to save the
changes.

Step 4 Click the Status tab and
click the Device Info button.
Your IP Address information will
be displayed under the WAN
heading.
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Frequently Asked Questions (continued)

How can I setup my router to work with Earthlink DSL or any PPPoE
connection?

Make sure you disable or uninstall any PPPoE software such as WinPoet or Enternet
300 from your computer or you will not be able to connect to the Internet.

Step 1 Upgrade Firmware if needed.

(Please visit the D-Link tech support website at: http://support.dlink.com for the latest
firmware upgrade information.)

Step 2 Take a paperclip and perform a hard reset. With the unit on, use a paperclip
and hold down the reset button on the back of the unit for 10 seconds. Release it and
the router will recycle, the lights will blink, and then stabilize.

Step 3 After the router stabilizes, open your browser and enter 192.168.0.1 into the
address window and hit the Enter key. When the password dialog box appears, enter
the username admin and leave the password blank. Click OK.

If the password dialog box does not come up repeat Step 2.

Note: Do not run Wizard.

Step 4 Click on the WAN tab on left-hand side of the screen. Select PPPoE.

Step 5 Select Dynamic PPPoE (unless your ISP supplied you with a static IP
Address).

Step 6 In the username field enter ELN/username@earthlink.net and your
password, where username is your own username.

For SBC Global users, enter username@sbcglobal.net.
For Ameritech users, enter username@ameritech.net.
For BellSouth users, enter username@bellsouth.net.
For Mindspring users, enter username@mindspring.com.
For most other ISPs, enter username.

Step 7 Maximum Idle Time should be set to zero. Set MTU to 1492, unless
specified by your ISP, and set Autoreconnect to Enabled.

Note: If you experience problems accessing certain websites and/or email issues,
please set the MTU to a lower number such as 1472, 1452, etc. Contact your ISP for
more information and the proper MTU setting for your connection.
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Step 8 Click Apply. When prompted, click Continue. Once the screen refreshes,
unplug the power to the D-Link router.

Step 9 Turn off your DSL modem for 2-3 minutes. Turn back on. Once the modem
has established a link to your ISP, plug the power back into the D-Link router. Wait
about 30 seconds and log back into the router.

Step 10 Click on the Status tab in the web configuration where you can view the
device info. Under WAN, click Connect. Click Continue when prompted. You should
now see that the device info will show an IP Address, verifying that the device has
connected to a server and has been assigned an IP Address.

How can I setup my router to work with Earthlink DSL or any PPPoE
connection? (continued)

Frequently Asked Questions (continued)

Can I use my D-Link Broadband Router to share my Internet
connection provided by AOL DSL Plus?

In most cases yes. AOL DSL Plus may use PPPoE for authentication bypassing the
client software. If this is the case, then our routers will work with this service. Please
contact AOL if you are not sure.

To set up your router:

Step 1Log into the web based configuration by typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The username is admin (all lowercase) and
the password is blank (empty).

Step 2 Enter your screen name followed by @aol.com for the user name. Enter your
AOL password in the password box.

Step 3 You will have to set the MTU to 1400. AOL DSL Plus does not allow for
anything higher than 1400.

Step 4 Click Apply.

Step 5 Recycle the power to the modem for 1 minute and then recycle power to the
router. Allow 1 to 2 minutes to connect.

If you connect to the Internet with a different ISP and want to use the AOL software,
you can do that without configuring the router’s firewall settings. You need to
configure the AOL software to connect using TCP/IP.
Go to http://www.aol.com for more specific configuration information of their software.
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Frequently Asked Questions (continued)

How do I open ports on my router?

To allow traffic from the Internet to enter
your local network, you will need to open
up ports or the router will block the
request.

Step 1 Log into the web based
configuration by typing in the IP Address
of the router (default:192.168.0.1) in your
web browser. The username is admin (all
lowercase) and the password is blank
(empty).

Step 2 Click on Advanced on top and
then click Virtual Server on the left

Step 6 Choose Protocol Type - either TCP, UDP, or both. If you are not sure, select
both.

Step 7 Enter the port information next to Private Port and Public Port. The private
and public ports are usually the same. The public port is the port seen from the WAN
side, and the private port is the port being used by the application on the computer
within your local network.

Step 8 Set  the Schedule information.

Step 9 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled. If DMZ is enabled, it will disable all Virtual
Server entries.

Because our routers use NAT (Network Address Translation), you can only open a specific
port to one computer at a time. For example: If you have 2 web servers on your network,
you cannot open port 80 to both computers. You will need to configure one  of the web
servers to use port 81. Now you can open port 80 to the first computer.

Step 3 Check Enabled to activate
entry.

Step 4 Enter a name for your virtual
server entry.

Step 5 Next to Private IP, enter the IP
Address of the computer on your local
network that you want to allow the
incoming service to.
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Frequently Asked Questions (continued)

What is DMZ?

Demilitarized Zone:
In computer networks, a DMZ (Demilitarized Zone) is a computer host or small
network inserted as a neutral zone between a company´s private network and the
outside public network. It prevents outside users from getting direct access to a
server that has company data. (The term comes from the geographic buffer zone that
was set up between North Korea and South Korea following the UN police action in
the early 1950s.) A DMZ is an optional and more secure approach to a firewall and
effectively acts as a proxy server as well.

In a typical DMZ configuration for a small company, a separate computer (or host in
network terms) receives requests from users within the private network for access to
Web sites or other companies accessible on the public network. The DMZ host then
initiates sessions for these requests on the public network. However, the DMZ host is
not able to initiate a session back into the private network. It can only forward packets
that have already been requested.

Users of the public network outside the company can access only the DMZ host. The
DMZ may typically also have the company´s Web pages so these could be served to
the outside world. However, the DMZ provides access to no other company data. In
the event that an outside user penetrated the DMZ hosts security, the Web pages
might be corrupted but no other company information would be exposed. D-Link, a
leading maker of routers, is one company that sells products designed for setting up
a DMZ

How do I configure the DMZ Host?

The DMZ feature allows you to forward all incoming ports to one computer on the local
network. The DMZ, or Demilitarized Zone, will allow the specified computer to be
exposed to the Internet. DMZ is useful when a certain application or game does not
work through the firewall. The computer that is configured for DMZ will be completely
vulnerable on the Internet, so it is suggested that you try opening ports from the
Virtual Server or Firewall settings before using DMZ.

Step 1 Find the IP address of the computer you want to use as the DMZ host.

To find out how to locate the IP Address of the computer in Windows XP/2000/ME/9x
or Macintosh operating systems please refer to Step 4 of the first question in this
section (Frequently Asked Questions).

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


91

Frequently Asked Questions (continued)

Step 2 Log into the web based configuration
of the router by typing in the IP Address of the
router (default:192.168.0.1) in your web
browser. The username is admin (all
lowercase) and the password is blank
(empty).

How do I configure the DMZ Host? (continued)

Step 3 Click the Advanced tab and then click on the DMZ button. Select Enable
and type in the IP Address from Step 1.

Step 4 Click Apply
and then Continue to
save the changes.

Note: When DMZ is
enabled, Virtual Server
settings will still be
effective. Remember,
you cannot forward the
same port to multiple
IP Addresses, so the
Virtual Server settings
will take priority over
DMZ settings.
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Frequently Asked Questions (continued)

How do I open a range of ports on my DI-704UP using Firewall rules?

Step 1 Log into the web based configuration by typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The username is admin (all lowercase) and
the password is blank (empty).
If you are having difficulty accessing web management, please see the first question
in this section.
Step 2 From the web management Home page, click the Advanced tab then click
the Firewall button.

Step 3 Click on
Enabled and type in a
name for the new rule.

Step 4 Choose WAN
as the Source and
enter a range of IP
Addresses out on the
internet that you would
like this rule applied
to. If you would like
this rule to allow all
internet users to be
able to access these
ports, then put an
Asterisk (*) in the first
box and leave the
second box empty.

Step 5 Select LAN as the Destination and enter the IP Address of the computer on
your local network that you want to allow the incoming service to. This will not work
with a range of IP Addresses.
Step 6 Enter the port or range of ports that are required to be open for the incoming
service.

Step 7 Click Apply and then click Continue.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer
and then open port 81 to the other computer.

Note: Make sure DMZ host is disabled.
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Frequently Asked Questions (continued)

What are virtual servers?

A Virtual Server is defined as a service port, and all requests to this port will be
redirected to the computer specified by the server IP. For example, if you have an FTP
server (port 21) at 192.168.0.5, a Web server (port 80) at 192.168.0.6, and a VPN
server (port 1723) at 192.168.0.7, then you need to specify the following virtual server
mapping table:

Server Port Server IP Enable

  21       192.168.0.5 X

80     192.168.0.6          X

1723       192.168.0.7 X

How do I use PC Anywhere with my DI-704UP router?

You will need to open 3 ports in the Virtual Server section of your D-Link router.

Step 1 Log into the web based configuration by typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The username is admin (all lowercase) and
the password is blank (empty).

Step 4 The first entry will read
as shown here:

Step 5 Click Apply and then
click Continue.

Step 3 Enter the information as
seen below. The Private IP is the
IP Address of the computer on
your local network that you want
to connect to.

pcanywhere1

Step 2 Click on Advanced at the
top and then click Virtual Server
on the left side.
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Frequently Asked Questions (continued)

Step 6 Create a second entry as shown.

Step 7 Click Apply and then click
Continue.

Step 8 Create a third and final entry as shown here:

Step 10 Run PCAnywhere from the remote site and use the WAN IP Address of the
router, not your computer´s IP Address.

Step 9 Click Apply and then click
Continue.

pcanywhere2

pcanywhere3

How do I use PC Anywhere with my DI-704UP router? (continued)
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How can I use eDonkey behind my D-Link Router?

Frequently Asked Questions (continued)

You must open ports on your router to allow incoming traffic while using eDonkey.

eDonkey uses three ports (4 if using CLI):

4661 (TCP) To connect with a server
4662 (TCP) To connect with other clients
4665 (UDP) To communicate with servers other than the one you are connected to.
4663 (TCP) *Used with the command line (CLI) client when it is configured to allow
remote connections. This is the case when using a Graphical Interface (such as the
Java Interface) with the client.

Step 1  Log into the web based configuration by typing in the IP Address of the
router (default:192.168.0.1) in your web browser. The username is admin (all
lowercase) and the password is blank (empty).

Step 4 Click Apply and then Continue.

Step 2 Click on
Advanced and then click
Firewall.

Step 3 Create a new
firewall rule:
Click Enabled.
Enter a name (edonkey).
Click Allow. Next to
Source, select WAN under
interface. In the first box,
enter an *. Leave the
second box empty. Next to
Destination, select LAN
under interface. Enter the
IP Address of the computer
you are running eDonkey
from. Leave the second
box empty. Under Protocol, select *. In the port range boxes, enter 4661 in the first
box and then 4665 in the second box. Click Always or set a schedule.

edonkey

WAN

LAN 192.168.0.100 4661 4665
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Frequently Asked Questions (continued)

To play SOCOM and hear audio, you must download the latest firmware for the router
(if needed), enable Game Mode, and open port 6869 to the IP Address of your
Playstation.

Step 1 Upgrade the firmware.

Step 2  Log into the web based configuration by typing in the IP Address of the
router (default:192.168.0.1) in your web browser. The username is admin (all
lowercase) and the password is blank (empty).

Step 3 Click on the Advanced tab and then click on Virtual Server on the left side.

Step 4 You will now create a new Virtual Server entry. Click Enabled and enter a
name (socom). Enter the IP Address of your Playstation for Private IP.

Step 5 For Protocol Type select Both. Enter 6869 for both the Private Port and
Public Port. Click Always. Click Apply to save changes and then Continue

Step 6 Click on the Tools tab and then Misc on the left side.

Step 7 Make sure Gaming Mode is Enabled. If not, click Enabled. Click Apply
and then Continue.

How do I set up my router for SOCOM on my Playstation 2?

socom
100

6869

6869

Both
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NAME - Gamespy1

PRIVATE IP - The IP
Address of your computer
that you are running
Gamespy from.

PROTOCOL TYPE - Both

PRIVATE PORT - 3783

PUBLIC PORT - 3783

SCHEDULE - Always.

NAME - Gamespy2

PRIVATE IP - The IP Address of
your computer that you are
running Gamespy from.

PROTOCOL TYPE - Both

PRIVATE PORT - 6500

PUBLIC PORT - 6500

SCHEDULE - Always.

Frequently Asked Questions (continued)

Step 1  Log into the web based configuration by typing in the IP Address of the
router (default:192.168.0.1) in your web browser. The username is admin (all
lowercase) and the password is blank (empty).
Step 2 Click on the Advanced tab and then click Virtual Server on the left side.

Step 3 You will create 2 entries.

Step 4 Click Enabled and enter settings:

Click Apply and then Continue

Step 5 Click Enabled and enter settings:

Click Apply and then Continue.

How can I use Gamespy behind my D-Link router?

Both

100

gamespy1

3783

3783

100

gamespy2

Both

6500

6500
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Note: Make sure that you did not enable proxy/firewall in the KaZaA software.

Frequently Asked Questions (continued)

How do I configure my router for KaZaA and Grokster?

The following is for KaZaA, Grokster, and others using the FastTrack P2P file sharing
system.

In most cases, you do not have to configure anything on the router or on the Kazaa
software. If you are having problems, please follow steps below:

Step 1 Log into the web based configuration by typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The username is admin (all lowercase) and
the password is blank (empty).

Step 2 Click on Advanced and then click Virtual Server.

Step 3 Click Enabled and then enter a Name (kazaa for example).

Step 4 Enter the IP Address of the computer you are running KaZaA from in the
Private IP box. Select TCP for the Protocol Type.

Step 5 Enter 1214 in the Private and Public Port boxes. Click Always under
schedule or set a time range. Click Apply.

kazaa

100

6500

6500
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Frequently Asked Questions (continued)

How do I configure my router to play  Warcraft 3?

To host a Warcraft 3 game, you must open ports on your router to allow incoming
traffic. To play a game, you do not have to configure your router.

Warcraft 3 (Battlenet) uses port 6112.

For the DI-704UP:

Step 4 Click Apply and then Continue.

Note: If you want multiple computers from you LAN to play in the same game that
you are hosting, then repeat the steps above and enter the IP Addresses of the other
computers. You will need to change ports. Computer #2 can use port 6113, computer
#3 can use 6114, and so on.

You will need to change the port information within the Warcraft 3 software for
computers #2 and up.

Configure the Game Port information on each computer:
Start Warcraft 3 on each computer, click Options > Gameplay. Scroll down and you
should see Game Port. Enter the port number as you entered in the above steps.

Step 1 Log into the web based
configuration by typing in the IP
Address of the router
(default:192.168.0.1) in your web
browser. The username is admin
(all lowercase) and the password is
blank (empty).

Step 2 Click on Advanced and
then click Virtual Server.

Step 3 Create a new entry: Click
Enabled. Enter a name (warcraft3).
Private IP - Enter the IP Address of
the computer you want to host the
game. Select Both for Protocol Type
Enter 6112 for both Private Port and
Public Port Click Always or set a
schedule.

100

warcraft3

6112

6112

both
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Frequently Asked Questions (continued)

How does NetMeeting work with my D-Link Router?

Unlike most TCP/IP applications, NetMeeting uses DYNAMIC PORTS instead of
STATIC PORTS. That means that each NetMeeting connection is somewhat different
than the last. For instance, the HTTP web site application uses port 80. NetMeeting
can use any of over 60,000 different ports.

All broadband routers using only standard NAT and all internet sharing programs like
Microsoft ICS that use only standard NAT will NOT work with NetMeeting or other
h.323 software packages.

In order to use NetMeeting with your D-LInk router, you need to put the router in DMZ.

Note: A few hardware manufacturers have taken it on themselves to actually provide
H.323 compatibility. This is not an easy task since the router must search each
incoming packet for signs that it might be a netmeeting packet. This is a whole lot
more work than a router normally does and may actually be a weak point in the
firewall. D-Link is not one of the manufacturers.

To read more on this visit http://www.HomenetHelp.com

How do I set up my router to use iChat?  -for Macintosh users-

You must open ports on your router to allow incoming traffic while using iChat.

iChat uses the following ports: 5060 (UDP) 5190 (TCP) File Sharing 16384-16403
(UDP) to video conference with other clients

Step 1 Log into the web based configuration by typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The username is admin (all lowercase) and
the password is blank (empty).

Step 2 Click on Advanced and then click Firewall.
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Frequently Asked Questions (continued)

Step 3 Create a new firewall rule:

Leave the second box empty. Under  Protocol, select UDP. In the port range boxes,
enter 5060 in the first box and leave the second box empty.
Click Always or set a schedule.

Step 4 Click Apply and then
Continue.

Step 5
Repeat steps 3 and 4 enter
ichat2 and open ports 16384-
16403 (UDP).

How do I set up my router to use iChat? -for Macintosh users-
(continued)

Click Enabled.
Enter a name (ichat1).

Click Allow.

Next to Source, select
WAN under interface.

In the first box, enter an *.
Leave the second box
empty.

Next to Destination, select
LAN under interface.

Enter the IP Address of the
computer you are running
iChat from.

ichat1

WAN

LAN 192.168.0.100 UDP 5060

ichat2

WAN

LAN 192.168.0.100 UDP 1638 1640
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Frequently Asked Questions (continued)

If using Mac OS X Firewall, you may need to temporarily turn off the firewall in
the Sharing preference pane on both computers.
To use the Mac OS X Firewall, you must open the same ports as in the router:

Step 1 Choose Apple menu > System Preferences.
Step 2 Choose View > Sharing.
Step 3 Click the Firewall tab.
Step 4 Click New.
Step 5 Choose Other from the Port Name pop-up menu.
Step 6 In the Port Number, Range or Series field, type in: 5060, 16384-16403.
Step 7 In the Description field type in: iChat AV
Step 8 Click OK.

For File Sharing:
Step 1 Click on Advanced and
then Virtual Server.

Step 2 Check Enabled to activate
entry.

Step 3 Enter a name for your virtual
server entry (ichat3).

Step 4 Next to Private IP, enter the
IP Address of the computer on your
local network that you want to allow
the incoming service to.

Step 5 Select TCP for Protocol
Type.

Step 6 Enter 5190 next to Private
Port and Public Port.

How do I set up my router to use iChat? -for Macintosh users-
(continued)

Step 7 Click Always or configure a schedule.

Step 8 Click Apply and then Continue.

ichat3

100

6500

6500
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Frequently Asked Questions (continued)

How do I send or receive a file via iChat when the Mac OSX firewall
is active? -for Macintosh users- Mac OS X 10.2 and later

“iChat cannot send or receive a file when the Mac OS X firewall is active in its default
state. If you have opened the AIM port, you may be able to receive a file but not send
them.

In its default state, the Mac OS X firewall blocks file transfers using iChat or America
Online AIM software. If either the sender or receiver has turned on the Mac OS X firewall,
the transfer may be blocked.

The simplest workaround is to temporarily turn off the firewall in the Sharing preference
pane on both computers. This is required for the sender. However, the receiver may keep
the firewall on if the AIM port is open. To open the AIM port:

If you do not want to turn off the firewall at the sending computer, a different file sharing
service may be used instead of iChat. The types of file sharing available in Mac OS X are
outlined in technical document 106461, "Mac OS X: File Sharing" in the AppleCare Knowl-
edge base online.

Note: If you use a file sharing service when the firewall is turned on, be sure to click the
Firewall tab and select the service you have chosen in the "Allow" list. If you do not do
this, the firewall will also block the file sharing service. “

The following information is from the online Macintosh AppleCare knowledge base:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.

Step 3 Click the Firewall tab.

Step 4 Click New.

Step 5  Choose AOL IM from the Port Name pop-up menu. The number 5190
should already be filled in for you.

Step 6 Click OK.
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What is NAT?

NAT stands for Network Address Translator. It is proposed and described in RFC-
1631 and is used for solving the IP Address depletion problem. Each NAT box has a
table consisting of pairs of local IP Addresses and globally unique addresses, by
which the box can “translate” the local IP Addresses to global address and vice versa.
Simply put, NAT is a method of connecting multiple computers to the Internet (or any
other IP network) using one IP Address.

D-Link´s broadband routers (ie: DI-704UP) support NAT. With proper configuration,
multiple users can access the Internet using a single account via the NAT device.

For more information on RFC-1631: The IP Network Address Translator (NAT), visit
http://www.faqs.org/rfcs/rfc1631.html

Frequently Asked Questions (continued)
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Technical Support
You can find  software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and
within Canada for the duration of the warranty period on this product.

U.S. and Canadian customers can contact D-Link technical support through our
website, or by phone.

Tech Support for customers within the United States:
D-Link Technical Support over the Telephone:
(877) 453-5465
24 hours a day, seven days a week.

D-Link Technical Support over the Internet:
http://support.dlink.com
email:support@dlink.com

Tech Support for customers within Canada:
D-Link Technical Support over the Telephone:
(800) 361-5265
Monday to Friday 7:30am to 12:00am EST

D-Link Technical Support over the Internet:
http://support.dlink.ca
email:support@dlink.ca
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Warranty
(USA only)
Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited
warranty for its product only to the person or entity that originally purchased the product from:
• D-Link or its authorized reseller or distributor and
• Products purchased and delivered within the fifty states of the United States, the District of Columbia,

U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an APO or FPO.
Limited Warranty:  D-Link warrants that the hardware portion of the D-Link products described
below will be free from material defects in workmanship and materials from the date of original retail
purchase of the product, for the period set forth below applicable to the product type (“Warranty
Period”), except as otherwise stated herein.
1-Year Limited Warranty for the Product(s) is defined as follows:

• Hardware (excluding power supplies and fans) One (1) Year
• Power Supplies and Fans One (1) Year
• Spare parts and spare kits Ninety (90) days
D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period
at no charge to the original owner or to refund at D-Link’s sole discretion.  Such repair or replacement will
be rendered by D-Link at an Authorized D-Link Service Office.  The replacement Hardware need not be
new or have an identical make, model or part.  D-Link may in its sole discretion replace the defective
Hardware (or any part thereof) with any reconditioned product that D-Link reasonably determines is
substantially equivalent (or superior) in all material respects to the defective Hardware.  Repaired or
replacement Hardware will be warranted for the remainder of the original Warranty Period from the date
of original retail purchase.  If a material defect is incapable of correction, or if D-Link determines in its sole
discretion that it is not practical to repair or replace the defective Hardware, the price paid by the original
purchaser for the defective Hardware will be refunded by D-Link upon return to D-Link of the defective
Hardware.  All Hardware (or part thereof) that is replaced by D-Link, or for which the purchase price is
refunded, shall become the property of D-Link upon replacement or refund.
Limited Software Warranty:  D-Link warrants that the software portion of the product (“Software”)
will substantially conform to D-Link’s then current functional specifications for the Software, as set forth
in the applicable documentation, from the date of original retail purchase of the Software for a period of
ninety (90) days (“Warranty Period”), provided that the Software is properly installed on approved
hardware and operated as contemplated in its documentation. D-Link further warrants that, during the
Warranty Period, the magnetic media on which D-Link delivers the Software will be free of physical
defects.  D-Link’s sole obligation shall be to replace the non-conforming Software (or defective media)
with software that substantially conforms to D-Link’s functional specifications for the Software or to
refund at D-Link’s sole discretion.  Except as otherwise agreed by D-Link in writing, the replacement
Software is provided only to the original licensee, and is subject to the terms and conditions of the
license granted by D-Link for the Software.  Software will be warranted for the remainder of the original
Warranty Period from the date or original retail purchase.  If a material non-conformance is incapable of
correction, or if D-Link determines in its sole discretion that it is not practical to replace the non-
conforming Software, the price paid by the original licensee for the non-conforming Software will be
refunded by D-Link; provided that the non-conforming Software (and all copies thereof) is first returned
to D-Link.  The license granted respecting any Software for which a refund is given automatically
terminates.
Non-Applicability of Warranty:  The Limited Warranty provided hereunder for hardware and software
of D-Link’s products will not be applied to and does not cover any refurbished product and any product
purchased through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers,
or the liquidators expressly disclaim their warranty obligation pertaining to the product and in that case,
the product is being sold “As-Is” without any warranty whatsoever including, without limitation, the
Limited Warranty as described herein, notwithstanding anything stated herein to the contrary.

Submitting A Claim:  The customer shall return the product to the original purchase point based on its
return policy.  In case the return policy period has expired and the product is within warranty, the
customer shall submit a claim to D-Link as outlined below:
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• The customer must submit with the product as part of the claim a written description of the Hardware
defect or Software nonconformance in sufficient detail to allow D-Link to confirm the same.

• The original product owner must obtain a Return Material Authorization (“RMA”) number from the
Authorized D-Link Service Office and, if requested, provide written proof of purchase of the
product (such as a copy of the dated purchase invoice for the product) before the warranty
service is provided.

• After an RMA number is issued, the defective product must be packaged securely in the original or
other suitable shipping package to ensure that it will not be damaged in transit, and the RMA number
must be prominently marked on the outside of the package.  Do not include any manuals or accessories
in the shipping package.  D-Link will only replace the defective portion of the Product and will not
ship back any accessories.

• The customer is responsible for all in-bound shipping charges to D-Link.  No Cash on Delivery
(“COD”) is allowed.  Products sent COD will either be rejected by D-Link or become the property of
D-Link.  Products shall be fully insured by the customer. D-Link will not be held responsible for any
packages that are lost in transit to D-Link.  The repaired or replaced packages will be shipped to the
customer via UPS Ground or any common carrier selected by D-Link, with shipping charges prepaid.
Expedited shipping is available if shipping charges are prepaid by the customer and upon request.

• Return Merchandise Ship-To Address
USA: 17595 Mt. Herrmann, Fountain Valley, CA 92708
Canada: 2180 Winston Park Drive, Oakville, ON, L6H 5W1 (Visit http://www.dlink.ca for detailed
warranty information within Canada)

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the
foregoing requirements, or for which an RMA number is not visible from the outside of the package. The
product owner agrees to pay D-Link’s reasonable handling and return shipping charges for any product
that is not packaged and shipped in accordance with the foregoing requirements, or that is determined
by D-Link not to be defective or non-conforming.
What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link’s
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse,
faulty installation, lack of reasonable care, repair or service in any way that is not contemplated in the
documentation for the product, or if the model or serial number has been altered, tampered with, defaced
or removed; Initial installation, installation and removal of the product for repair, and shipping costs;
Operational adjustments covered in the operating manual for the product, and normal maintenance;
Damage that occurs in shipment, due to act of God, failures due to power surge, and cosmetic damage;
Any hardware, software, firmware or other products or services provided  by anyone other than D-
Link; Products that have been purchased from inventory clearance or liquidation sales or other sales in
which D-Link, the sellers, or the liquidators expressly disclaim their warranty obligation pertaining to the
product.  Repair by anyone other than D-Link or an Authorized D-Link Service Office will void this
Warranty.
Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE
PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING,
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE
AND NON-INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE DISCLAIMED IN ANY TERRITORY
WHERE A PRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO
NINETY (90) DAYS. EXCEPT AS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED
HEREIN, THE ENTIRE RISK AS TO THE QUALITY, SELECTION AND PERFORMANCE OF THE PRODUCT IS
WITH THE PURCHASER OF THE PRODUCT.

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


108

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE
UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY
FOR ANY LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER,
WHETHER DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO,
DAMAGES FOR LOSS OF GOODWILL, LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, COMPUTER
FAILURE OR MALFUNCTION, FAILURE OF OTHER EQUIPMENT OR COMPUTER PROGRAMS TO WHICH D-
LINK’S PRODUCT IS CONNECTED WITH, LOSS OF INFORMATION OR DATA CONTAINED IN, STORED ON,
OR INTEGRATED WITH ANY PRODUCT RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING
FROM THE USE OF THE PRODUCT, RELATING TO WARRANTY SERVICE, OR ARISING OUT OF ANY
BREACH OF THIS LIMITED WARRANTY, EVEN IF D-LINK HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. THE SOLE REMEDY FOR A BREACH OF THE FOREGOING LIMITED WARRANTY IS
REPAIR, REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-CONFORMING PRODUCT.  THE MAXIMUM
LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE PRODUCT
COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN WARRANTIES AND REMEDIES
ARE EXCLUSIVE AND ARE IN LIEU OF ANY OTHER WARRANTIES OR REMEDIES, EXPRESS, IMPLIED OR
STATUTORY
Governing Law:  This Limited Warranty shall be governed by the laws of the State of California. Some
states do not allow exclusion or limitation of incidental or consequential damages, or limitations on how
long an implied warranty lasts, so the foregoing limitations and exclusions may not apply. This limited
warranty provides specific legal rights and the product owner may also have other rights which vary
from state to state.

Trademarks:  D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered
trademarks are the property of their respective manufacturers or owners.

Copyright Statement:  No part of this publication or documentation accompanying this Product may
be reproduced in any form or by any means or used to make any derivative such as translation,
transformation, or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., as
stipulated by the United States Copyright Act of 1976.  Contents are subject to change without prior
notice.  Copyright© 2002 by D-Link Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning:  This is a Class B product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

FCC Statement:  This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates, uses, and
can radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communication. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged
to try to correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected.
• Consult the dealer or an experienced radio/TV technician for help.

For detailed warranty outside the United States, please contact corresponding local
D-Link office.
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Register your D-Link product online at http://support.dlink.com/
register/

10/08/04

Registration
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